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Welcome to 2016 Knowledge-Based Preparation, Compilation, and Reviews of Real Estate Entities for ProSystem 
fx® Knowledge Coach 
This Release Notes document provides important information about the 2016 release of Knowledge Based Preparation, Compilation, 
and Reviews of Real Estate Entities. Please review this information carefully. If you have any questions, contact Customer Support at 1-
800-PFX-9998, option 4, then option 1. Additional information is available on CCH Support Online. 

New in this Release  

Knowledge-Based Preparation, Compilation, and Reviews of Real Estate Entities is designed to help the accountant efficiently and 
effectively conduct preparation, compilation, and reviews of nonpublic Real Estate entities in accordance with Statements on Standards 
for Accounting and Review Services (SSARS) issued by the Accounting and Review Services Committee (ARSC) of the American Institute 
of Certified Public Accountants (AICPA). 

The Knowledge-Based Preparation, Compilation, and Review (KBPCR) methodology emphasizes using knowledge of the entity to 
perform preparation, compilation, and review engagements by facilitating the flow of information so that the understanding obtained in 
each process affects the decisions made in the next. Although the accountant will likely perform most steps in this methodology 
sequentially, conducting an engagement is not necessarily a linear process. Knowledge gained from preliminary engagement activities 
helps the accountant design and customize engagement procedures; evidence gained from procedures performed is evaluated and the 
appropriate accountant’s report, if any, is issued. This toolset includes specific up-to-date guidance for conducting preparation, 
compilation, and review engagements in accordance with the SSARS. 

Conducting preparation, compilation, and reviews of Real Estate entities requires the exercise of the accountant’s professional 
judgment. Additionally, the operations of nonpublic real estate entities are often unique and complex and may require specialized 
accounting knowledge. This edition includes specific up-to-date guidance for performing preparations, compilations and reviews of 
nonpublic real estate entities. 

This document is published for the purpose of communicating the updates and enhancements included in the current version to users 
of the toolset. This document is not, and should not be used as a program to update the documentation of an engagement started in a 
previous version of this product. 

The 2016 documents include Accounting Research Material links to specific guidance that provides instant access to detailed analysis 
related to the steps and processes discussed in the workpapers.  

This module includes separate titles for Preparation, Compilation, and Review Engagements.  Each title will need to be downloaded 
separately.   

The 2016 Knowledge-Based Preparation, Compilation, and Reviews of Real Estate Entities is current through: 

 SSARS No. 22, Compilation of Pro Forma Financial Information 

 SSARS No. 23, Omnibus Statement on Standards for Accounting and Review Services – 2016 
o The portion of SSARS 23 that relates to prospective financial information that is effective for compilations dated on 

or after May 1, 2016 is NOT included in this release but will be included in the next release. 

 AICPA Guide Preparation, Compilation and Review Engagements; 

 AICPA Statement on Quality Control Standards No. 8 (QC Section 10), A Firm's System of Quality Control (Redrafted); 

 Revised AICPA Code of Professional Conduct (Code), including ET Section 1.295, Nonattest Services; and 

 2014/2015 Audit Risk Alert Developments in Review, Compilation, and Financial Statement Preparation Engagements—2014/15. 

http://support.cch.com/productsupport/


2 

 

 FASB Accounting Standards Codification as of December 31, 2016, and through Accounting Standards Update (ASU) No. 2016-
19, including: 

o ASU No. 2016-16, Income Taxes (Topic740): Intra-Entity Transfers of Assets Other Than Inventory;  
o ASU No. 2016-17, Consolidation (Topic 810): Interests Held through Related Parties That Are under Common Control;  
o ASU No. 2016-18, Statement of Cash Flows (Topic 230): Restricted Cash; and 
o ASU No. 2016-19, Technical Corrections and Improvements. 

Click here for the 2016 Preparation, Compilation, and Reviews of Real Estate Entities Title Overview for Knowledge Coach Users 

Important Notes 

 Make sure to save changes to workpapers before closing the workpaper or the binder to ensure data is correctly updated. 

 If your Current Editor Knowledge Coach MS® Word workpapers become read-only or crash, please do the following: 

o Keep the binder with the affected workpapers open. 

o Highlight the workpaper in the binder window and go to Tools > Save Knowledge Coach Answers. 

 As of the December 2016 update to Engagement 7.5 and Knowledge Coach 2.5, you can open binders that contain Knowledge 
Coach workpapers when logged into the Shared File Room (SFR) mode in Engagement with the following restrictions:  

o Knowledge Coach workpapers cannot be edited in the SFR mode. 

o However, Knowledge Coach workpapers can be viewed as read-only, signed off on, and workpaper notes can be 
written on Knowledge Coach workpapers while in the SFR mode. 

o Non- Knowledge Coach workpapers can be edited in SFR mode without restriction. 

System Requirements 

 This title MUST be used with ProSystem fx ® Engagement version 7.5 or higher, ProSystem fx® Knowledge Coach version 2.5, 
2016 Financial Statement Base v4 or higher for the Financial Statement title.  If you have not installed the ProSystem fx® 
Engagement 7.5 and Knowledge 2.5, ensure that you do so before using this title. If you are upgrading from ProSystem fx® 
Engagement 7.1 or lower please contact Technical Support at 1-800-PFX-9998 for detailed instructions. 

 A minimum of 4GB of RAM is required for optimal performance when opening and navigating through ProSystem fx® 
Knowledge Coach workpapers. 

Download Instructions 

The 2016 Knowledge-Based Preparation, Compilation, and Reviews of Not-for-Profit Entities includes the Preparation, Compilation, and 
Review title packages which are three separate packages.   

You must run the License Update Utility BEFORE adding the 2016 Knowledge-Based Preparation, Compilation and Reviews of Not-for-
Profit Entities title to Engagement version 7.5 by performing the following steps: 

1. Download the License Update Utility and Engagement version 7.5 License Update Q3 or Q4 File from this site.  

2. Right click on PfxEngUpdateUtility and Run as administrator. 

3. Log in to the utility using your Admin login. 

4. Browse to LicenseUpdate7.5Q3_20170313.upd for Q3 update or LicenseUpdate7.5Q4_20170313.upd for Q4 update that was 
downloaded along with the utility. 

5. Click “OK” to run the update. 

6. You will receive a message when the update is complete. 

7. Before assigning licenses to your staff please retrieve an updated permission key.  Please see this Knowledge Base article on our 
website. 

8. Open the ProSystem fx Engagement Admin application and assign licenses to your staff. 

Note: Please use the 7.5 Q4 License Update File if you have run the CCH ProSystem fx Engagement 7.5 and Knowledge Coach 2.5 
December 2016 Update (Engagement version 7.5.100.1220 or later). If you have not yet run this update, please use the 7.5 Q3 License 
Update File. 

You can identify the application version by going to the Help > About window within the application. 

http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2016%20REL-PCR%20Title%20Overview%20for%20Knowledge%20Coach%20Users.pdf
https://support.cch.com/updates/Engagement/#engagementLicenseFiles
https://support.cch.com/kb/solution.aspx/sw3937
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Download the 2016 Knowledge Based Preparation, Compilation, and Reviews of Real Estate Entities titles from the ProSystem fx 
®Knowledge Coach Updates section of the ProSystem fx® Engagement Support Web site at the following URL: 
http://support.cch.com/updates/KnowledgeCoach, then select the Knowledge Coach Series and Download file link next to each of the 
2016 Knowledge-Based Preparation, Compilation, or Reviews of Real Estate Entities title. On some occasions the content package file 
(.KCP) will download with the extension changed to .ZIP. If this occurs, please change the extension of the downloaded file to KCP using 
all capital letters. 

You must install the 2016 Financial Statement Base v4 title before installing any of the 2016 Knowledge Based Preparation, 
Compilation, or Reviews of Real Estate Entities Titles.   

The Financial Statement Base title is also available at the following link: http://support.cch.com/updates/KnowledgeCoach    

Important: ProSystem fx® Engagement version 7.5 or higher and Knowledge Coach version 2.5 must be installed on the computer in 
order to install this Knowledge Coach title. Additional requirements include Microsoft® Office 2010, Microsoft® Office 2010 Primary 
Interop Assemblies (PIA) and Visual Studio® 2005 Tools for the Office Second Edition Runtime, Visual Studio® Tools for Office System 
Runtime version 3.0, and Visual Studio® Tools for the Office System 3.0 Runtime Service Pack 1., Visual Studio® Tools for Office 
Runtime 4.0 (VSTOR) (32-bit version for 32-bit OS and 64-bit version for 64-bit OS). 

The 2016 Knowledge-Based Preparation, Compilation, and Reviews of Real Estate Entities (03/30/2017) KCP download is a proprietary 
file that must be installed from within Engagement. Save this KCP file to a location on your local drive and follow the Installation 
Instructions included in the Release Bulletin. 

Installation Instructions 

Once you have downloaded your Knowledge Coach title, you will need to add it to the list of titles within ProSystem fx ® Engagement. 
The only additional system requirement is approximately 75MB of disk space to store your Knowledge Coach Program content files. 
Please refer to the ProSystem fx ® Engagement with Knowledge Coach Release Notes for any other system requirements.  

After downloading the 2016 Knowledge Based Preparation, Compilation, and Reviews of Real Estate Entities title, do the following: 

 Launch the ProSystem fx ® Engagement Workpaper Management application so that the Local File Room is displayed. Select 
Tools > Knowledge Coach Titles.  

 The Knowledge Coach Titles window will be displayed.  

 Choose Add Title.  

 Browse to the title package file (*.KCP) that you previously downloaded from the ProSystem fx ® Knowledge Coach Support 
Web site.  

 Choose Open.  

 The system will display a progress indicator while the title package is added. You will receive a message that the title has been 
successfully installed once the process is complete. 

 

Note: You can determine this access in the ProSystem fx® Engagement Admin module by selecting a staff group and choosing File > 
Properties > Content “Insert Knowledge Coach workpapers from unreleased titles” option. 

To release a title:  

 Select one of the Knowledge Coach titles in the list that has been added but is not yet released.  

 Choose Release Title. The current date and time will be displayed in the Date released column, and the status will change to 
“Released.”  

Note: You must add and assign a Knowledge Coach module as well as the Knowledge Coach title license in the ProSystem fx ® 
Engagement Administrator before using the workpapers.  

Important: Once the 2016 Knowledge-Based Preparation, Compilation, and Reviews of Real Estate Entities titles have been added and 
released, they will be automatically deployed to other staff members when they login to the “Office” location, or when they 
synchronize a binder that contains Knowledge Coach workpapers from this title.  

http://support.cch.com/updates/KnowledgeCoach
http://support.cch.com/updates/KnowledgeCoach
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Online Permission Key 

Permission key files may be downloaded from our Web site at https://prosystemfxsupport.tax.cchgroup.com/permkey/download.aspx 
or when adding or updating the new licenses within ProSystem fx® Engagement with Knowledge Coach version 7.5 and higher. After 
updating the license file in the ProSystem fx® Engagement Admin module, licenses need to be assigned to the staff who will use 2016 
Knowledge-Based Preparation, Compilation, and Reviews of Real Estate Entities. 

If you have not already established a Single Sign-on (SSO) account with Customer Service, we urge you to do so at this time.  

Accounting Research Manager 

CCH’s Accounting Research Manager ("ARM") is the most comprehensive, up-to-date and objective online database of financial 
reporting literature. It includes all authoritative and proposed accounting, auditing, and SEC literature, plus independent, expert-written 
interpretive guidance.  

Available on ARM, the Knowledge-Based Preparations, Compilations and Reviews of Real Estate Entities Guide helps you comply with 
the most recent professional standards and guidance for the conduct preparations, compilations and reviews and to integrate the use of 
practice aids, tools, and other resources with its guidance. This publication supplements and complements the Knowledge-Based 
documents that are available in Knowledge Coach. 

If you subscribe to an ARM library that includes Preparation, Compilation and Review content, you can link directly to source material 
from Resources within Knowledge Coach documents. These links have been updated to refer to the accounting standards under the 
FASB Accounting Standards Codifications.  

With Accounting Research Manager, you maximize the efficiency of your research time, while enhancing your results. Learn more about 
our content, our experts, and how you can request your free trial by visiting http://www.accountingresearchmanager.com. You can also 
access the Accounting Research Manager Web site by selecting the item in ProSystem fx ® Engagement from the Guidance tab on the 
Shortcuts bar in the Binder window.  

Using Your Knowledge Coach Content 

To use your Knowledge Coach Workpaper Templates, open a binder in ProSystem fx® Engagement, select the workpaper tab into which 
you would like to insert the workpaper, and select New Knowledge Coach Workpaper from the toolbar or File menu. The New 
Knowledge Coach Workpaper dialog appears (Figure 1).  

Select the New Knowledge Coach Title with the content you would like to use. You can only select titles you have installed. The 
information displayed changes to reflect the workpaper organization available for the selected title. Select the Knowledge Coach 
Workpaper Templates to insert into your binder and click OK. The Selected Workpaper Properties dialog appears. Each workpaper name 
is automatically loaded into the Name field. Add a workpaper index in the Index field and make any Name modifications you desire. 
You can also modify the tab location or the roll forward settings for each workpaper. Then click OK. The integrated Knowledge Coach 
workpaper is now inserted into your engagement binder. For more information on how to use Knowledge Coach workpapers in your 
binder, see the Knowledge Coach User Guide.  

https://prosystemfxsupport.tax.cchgroup.com/permkey/download.aspx
http://www.accountingresearchmanager.com/
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Additional Information on Knowledge Coach and the KBPCR Methodology 

Knowledge-Based Preparation, Compilation and Review (KBPCR) Methodology - Allows the results of one set of procedures to become 
the input for the next. The key components of the KBPCR methodology include: 

 An Overview that guides accountants through the KBPCR methodology; 

 Knowledge-Based Preparation, Compilation, and Review documents, integral to the overall engagement process, that contain 
steps and procedures required by SSARSs. 

 Customizable Preparation, Compilation and Review Programs that take accountants through related steps and procedures; 

 Practice Aids to help accountants complete steps or processes outlined in the Knowledge-Based Preparation, Compilation and 
Review documents and Programs; 

 Accountant’s Reports that provide a variety of sample accountant’s opinions on financial statements; and 

 Correspondence documents that provide sample letters to be used to comply with SSARS requirements and in many other 
common situations. 

 The AICPA’s Accounting and Review Services Committee (ARSC) SSARS - The practice aids and tools in the 2016 Knowledge-
Based Preparations, Compilations and Reviews of Real Estate Entities are designed around the AICPA’s SSARS standards to assist 
accountants by: 

 Facilitating compliance with SSARS;  

Figure 1 - New Knowledge Coach Workpaper 
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 Encouraging more effective engagements through tailored engagement programs and comprehensive practice aids; and  

 Enhancing engagement documentation. 

 

ProSystem fx® Knowledge Coach 

 ProSystem fx® Knowledge Coach functionality allows accountants to use the Knowledge-Based methodology more efficiently 
by eliminating the need for duplicate entry of the same information, tailoring documentation to each particular engagement, 
and documenting the link between risks identified and procedures performed. PRP-100 Tailoring Question Workpaper, CMP-100 
Tailoring Question Workpaper or REV-100 Tailoring Question Workpaper are documents in Knowledge Coach that presents 
engagement-level questions designed to aid in tailoring the engagement documentation to fit each client. Completing the 
questions helps the accountant avoid duplication and unnecessary workpapers.  

 Before you begin your engagement, please review the guidance in PRP-101 Overall Preparation Program, CMP-101 Overall 
Compilation Program or REV-101 Overall Review Program. These workpapers are intended to be your road map through the 
Knowledge-Based methodology. You should start your engagement with PRP-100 Tailoring Question Workpaper, CMP-100 
Tailoring Question Workpaper or REV-100 Tailoring Question Workpaper and PRP-101 Overall Preparation Program, CMP-101 
Overall Compilation Program or REV-101 Overall Review. 

 Refer to KBP-101 Preparation: Significant Matters, KBC-101 Compilation: Significant Matters and KBR-102 Review: Significant 
Matters to accumulate and review significant issues and findings. PRP-801 Preparation Program, CMP-801 Compilation 
Program: Significant Risks and Uncertainties and REV-802 Review Program: Significant Risks and Uncertainties provides a guide 
for implementing the guidance related to the disclosure of certain significant risks and uncertainties. 

 Information Flow helps cut down on the time spent duplicating information across forms. In addition, the flow of consistent 
information ensures that information and updates to information are not missed between workpapers. Drill-down functionality 
helps the user navigate quickly to the source of the information, aiding in the review of the engagement file. 

 Diagnostics help keep track of unresolved issues like unanswered questions, incomplete risks, program steps not linked to risks 
or relevant assertions, missing workpaper, and more.  

 Links to Accounting Research Manager (ARM)-If you subscribe to an ARM library that includes audit content, you can link 
directly to source material from Resources within Knowledge Coach workpapers. These links have been updated to reference to 
the accounting standards under the SSARS and accounting standards issued by the AICPA.  

 Interpretive Guidance is integrated into each Knowledge Coach template through the Tips view of each new task pane. 
Informational features include Practice Points, Examples, Optional Workpapers, and Resources to help accountants work more 
effectively and efficiently. You can also navigate from Resources within a document or the tip pane directly to CCH’s Accounting 
Research Manager and industry audit guides by simply clicking on the Reference.  

 

 

Download 
Description: 

2016 Knowledge-Based Preparation, Compilation, and 
Reviews of Real Estate Entities (3/30/2017) 

Version: 
Engagement v. 7.5 with Knowledge Coach 2.5 or higher and 
2016 Financial Statement Base v4  

Release Date: March 2017 

File size: 18MB 

Approx. Download 
Time: 

42 minutes at 56 kbps 

License: Full Version 

Platforms: Windows® 7, 8, 8.1, 10 
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Office: Microsoft® Office 2010 or higher required 

 

Contact Information 

 For a demo or to purchase additional titles as they become available 1-800-PFX-9998 

 Technical Support 1-800-PFX-9998 

The ProSystem fx® Engagement version of the Knowledge Coach Integrated Knowledge-Based Guides is sold and supported by CCH, a 
Wolters Kluwer business. The contact information above can be used for customer service and support issues for this product. For 
information about other CCH products, please call 1-800-248-3248 or visit the online Store at http://tax.cchgroup.com. 

 


